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Introduction








Your day begins. You've got five different appointments, four different things to do around the house, you've got to make dinner reservations for a night out and, to top it off, You need to come up with plans for a weekend getaway. The worst part? All needs to be done today.



If experience has taught us anything about approaching a day, week month or year packed with important appointments, vacations, school schedules and dozens – if not hundreds - of things to do around the house, it's this: an impossible schedule can only be made possible through organization.



We're not talking about the kind of organization where you scribble a few notes on a piece of paper, create some bookmarks on your phone and, if you have time, send off a few texts to plan something.



We're talking about a smooth, elegant type of organization that not only keeps your crazy life together, but also does it in a way that makes you actually
 want
 to organize because it's fun.



That's OneNote, the Microsoft organization app created specifically for your busiest days, Your most hectic weeks and those insane months where you barely get a chance to catch your breath between all the tasks you have to finish.



Microsoft first release OneNote in 2003, and since then there have three versions: OneNote 2007, 2010 and 2013. The newest version of OneNote is available on iOS, Android and Windows phones as well as the standard desktop version.



The apps' popularity has grown as each new version has come out, and once you get into this books you'll realize why – it's a fantastic tool for organizing and coordinating all kinds of events and daily tasks. If you want to get things done, get them done with OneNote.


















Chapter 1 – Getting Started








If you're using OneNote for the first time, be prepared to wait one or two minutes for the app to start up. If you're a Windows 8 or Windows 10 user, your Microsoft Live account will automatically link your OneNote account the profile you used to log in to your computer after start-up.



Once OneNote opens up, you'll be faced with a very simple user experience. The menu bar at the top of the window will give you seven options: Home, Insert, Draw, History, Review and View



The sub menu underneath the main menu includes the different projects on which you're working. On the left side of the sub menu is the “Notebook” tab, which is pretty much like a school notebook. It belongs to a certain person (in this case, a Microsoft account) and has its own pages, which are designated by tabs to the right of the Notebook tab.



You can add different Notebooks whenever you want. Each time you start a new notebook, you'll have the option of sharing it with other people. It remains the same no matter which main-menu tab you use.







Home







OneNote's Home menu is where you'll find all the necessary formatting tools to make your notes clear and organized. The Home menu is divided into tree sections: Clipboard, Basic Text, Styles, Tags and Email.







Clipboard







This section includes your one-click cut, copy and paste tools, as well as a “format painter” that lets you apply formatted settings to any new section in your notes.







Basic Text







This part of the drop-down menu contains all the basic font and text tools you're accustomed to seeing in word processors like Word, Pages and Google Docs.



You have the ability to change the size and style of the font, as well as make text bold, underlined and italicized. Outline, indent and paragraph alignment tools are available here as well. Everything you need to format the text on your page is here.







Styles




This straightforward section lets you choose specific styles for your text. Go here to turn average text into headings, quotes, page titles and more.







Tags







If you like to keep things prioritized and organized, this is your section. The Tags tools allow you to create checklists, star important points and add a long list of icons to make certain items in your notes stand out.



You'll also find the “To Do” checklist box in this section. Use this tool to make a checklist of things to do. Be specific in your wording, as these checklist items can be searched according to keywords included in them.







Email







Ready to send your notes to someone else? Click on the email button to let other people view your notes.







Insert







The Insert menu in OneNote is a powerhouse for multimedia elements you want to incorporate into your notes.



When you click on “Insert”, you'll get a drop down menu split into nine different sections: Insert, Tables, Files, Images, Links, Recording, Time Stamp, Pages and Symbol. We'll take a brief look at most of these sections.











Insert







This section has one tool: “Insert Space”. This nifty little function lets you push elements of your notes down the page to make way for more notes.







Tables







Want to add a spreadsheet to your notes? Click on the “Table” button and you'll get a drop down menu that allows you to choose the size of your table, ranging from just one row and one column to a 10x8 table.







Images







If you love notes with pictures, you'll find almost everything you need in this section. Use the different tools in this section to grab a photo from your screen, pull photos from your computer, grab photos online or upload a scanned image into your notes.







Links







This section has a single tool which allows you to insert a hyperlink into any text in your notes.







Recording







The Recording options in OneNote are fantastic and you'll find how useful they are anytime you have to interview someone or record something. Both the audio and video recording options function in the same way:



They start recording when you click on their icons and they don't stop until you press the “Stop” button.



When the recording starts, OneNote puts a new text box in your notes which includes space to write as well as an icon indicating the recording.



When the recording stops, a small time-stamp button will appear when you move your cursor over any new sentence in your recording notes. Click on the time-stamp button and OneNote cues up the moment in the recording at which you type the sentence.







Time Stamp







This section of tools is as simple as they come. Click on any one of the icons to insert time, date or time and date into your notes.







Pages







OneNote offers you a variety of different templates based on style, background and other factors. The two most interesting options here are “Decorative” and “Planners.” The Decorative templates offer great, clean designs for your notes while Planners gives you decorative pages with preset check boxes and prioritized sections. If you don't want to spend the time creating your own checklists, the Planners templates are a great resource.







Symbol







Go to this Insert menu option to insert equations or special characters into your notes.







Draw







For the sake of keeping things simple, we're going to take a brief look at the Draw sub-menu in OneNote. Use the Draw tools for creating shapes or drawings.



You have the ability to change colors, thickness and the style of pen you use for your notes, as well as the ability to erase things you've drawn. The capabilities here are reminiscent of Microsoft's Paint app.











History, Review & View







The final three menus in OneNote are very basic and utilitarian. Use
 History
 to flip through your notes pages, read unread notes, find notes by author and review different versions of the same page.



The
 Review
 is a grammar-related collection of tools: spelling, thesaurus, language settings and several other elements. The
 View
 tab gives you a variety of options for viewing your notes.







Conclusion







This overview of OneNote gives you a sense of what features the app gives you and where you can find them. In our next chapter, we'll take you through the “Home” menu option and show you what tool are available to maximize your organization and help get things done.






















Chapter 2 – Shopping Made Easy








As you read in the previous chapter, OneNote has a tremendous amount of tools and resources to help you organize your life.



However, trying to understand how to use the various tools for specific life situations can be a bit overwhelming.



Think of your day as a painting. OneNote offers you the brushes, paints and accessories in order to create a painting that makes sense to you and makes sense to others.



The idea sounds great, in principle, doesn't it? A whole palate of colors, great brushes and a blank canvas on which you can create your daily masterpiece. Yet if you've never taken a painting class and have no idea how to use the individual brushes laid out before you, you'll never be able to to create the perfecti0n you envision.



Think of the following few chapters as a guide on how to create that elusive masterpieces you've been searching for as you try and make sense of the frenetic race that is your daily life.







Shopping The Right Way: OneNote for the Supermarket







Have you ever had that moment where you walk through the doors of your local grocery store ready to shop, only to reach into your pocket and realize the list you wrote on a piece of paper earlier in the day has mysteriously disappeared?



It's a frustrating feeling, especially if you your time is valuable and you don't have an extra 30 minutes or hour to go back home, get your shopping list and head back to the store.



Those frustrating moments don't have to happen again.



OneNote's mobile app allows you to easily make checklists for your shopping trip using some of the features we talked about above.



You'll be really surprised to see how simple the user experience is on the mobile version of OneNote. In fact, Microsoft's OneNote app has a preset template for shopping.



When you open the app for the first time, you can get to the sample shopping list by tapping “My Notebook”, then tapping “Quick Notes”.



The sample shopping list will be in the left-hand side of your screen. Tap it and you'll see the nifty little list that will make your shopping life a whole lot easier.



You can customize the shopping list by starting with a new note. If you're already in your personal notebook, you can start a new collection of notes by taping the “+ Section” button in the top left-hand part of the screen .From here, you'll be able to add a new page of notes by swiping the screen left and clicking on “+ Page”.



OneNote's mobile app is simplified, which is a good thing for small tasks like shopping.



When you're new page is open, you'll notice the check box at the top of the screen. Tap the box to add a check box to where your cursor is on your note page.



Do you remember how the desktop version of OneNote allows you to place a check box (or any other element, for that matter) wherever you want on the page, the mobile version limits your placement to line-by-line elements? You have the same capabilities in the mobile version of OneNote.







Creating a Checklist







When you add a check box, OneNote creates a window that includes your check box. The app automatically moves your cursor to the right of the box so you can add your text immediately.



If you want to add more check boxes to your list, simply tap the return button on your keyboard and a new check box will appear within the window.



To emphasize a certain item, use the Ink tool. To find the ink tool, tap on the vertical line of three squares in the top right-hand side of the screen.



Select from the type of pen you want to use, then start highlighting, drawing arrows or circling the things that need to stand out.



Once Your done with your doodling, you can tap the edit pencil on the top of the screen to end the Ink function and return you to your keyboard.



















Adding Helpful Elements







Imagine yourself in the middle of your shopping trip, frustrated and annoyed that you can't find a certain brand of product.



Let's say, for example, you're looking for certain kind of curry that you love. You've got the name of it on your checklist but you can't seem to find it on the shelf.



All the curry products have weird names and trying to find your particular brand is pretty much impossible, partly because the selection is overwhelming and partly because you don't want to waste a lot of time looking for curry.



Here's what you need to do to make sure you don't spend 10 minutes looking for something you could find in 10 seconds with one easy trick.



Before you leave for your shopping trip, open up your checklist on OneNote and go to your kitchen. Find the item you want to buy – curry, in this case – and tap the camera icon at the top of your screen. Then select “Capture from Camera”. Take a photo of the curry. OneNote will instantly add it to your checklist.



Now that you've got a photo of the beloved item you want to buy, you'll be able to recognize it with ease and save yourself valuable time.














Chapter 3 – Cutting Down on the Christmas Madness








When the holidays roll around, so does the stress.



Think about everything that comes with the yuletide season: presents, decorations, visiting family, school events, work parties and more. Trying to make sense of it all can lead to some very frustrating moments in a time of the year when everyone is supposed to be at their happiest.



The stress of this season is even more acute because of the significance of all these moments. For instance, if you dutifully buy all the presents you were supposed to buy for people but forget the dinner you planned with your neighbor, someone going to get mad and you're going to be left wondering how you could have missed the meet-up with your friends.



Making it to all the dinners, parties and stage productions but forgetting someone's present can also bring a dark cloud over the festivities.



The point here is that even missing just one important event can be taxing for your emotions and a strain on your relationships. OneNote's set of desktop tools will help ensure that you never have to miss another present, recital, dinner or party ever again.







Using Notebooks to Keep Things Simple







Like we mentioned earlier in the “Getting Started” chapter, OneNote allows you to make several notebooks. Think of them like the real notebooks you used during your elementary school years. You had one notebook for math, one notebook for science, one notebook for English and other notebooks for other subjects.



Consider the holiday season as school subject, and use OneNote's notebook function to keep all your holiday notes in one place.



When you open OneNote, you'll need to click on the File menu and then click on New. You'll be given the option to save your new notebook wherever you'd like. Choose the option that's the best fit for you. Name the new notebook – for the sake of example, let's call it “Holiday Planning”.



Once you've created your Holiday Planning notebook, you're ready to use OneNote's full capabilities to ensure Your on top of everything this holiday season.



Before you start typing out notes, creating checklists, highlighting the can't-miss events and linking to gifts, think about how you want to organize the notes withing your notebook.



Going back to the school subject example, think of Holiday Planning as your subject. Now think about how you want to divide that subject up. If you were in an American history class, your learning schedule would be divided up into different historical periods: the discovery years, the revolutionary years, the Civil War years and so on.



Your Holiday Planning notebook should be organized the same way: gift shopping, dinners and parties, family events, recitals and so on. For example's sake, let's create folders named Gifts, Dinners/Parties and Family Events.



Creating these different sections is easy. When you open your Holiday Planning notebook, you'll already be in the first section of the your notes. To rename the section “Gifts”, go to the New Section’s tab at the top of your notes and right-click on it. Select Rename and then give the section its new name.



Create your other sections by clicking on the “+” button next to the tab of your current section.



At this point, you have the freedom to make your sections as complex or as simple as you'd like. If you're a planning fanatic, here are a few tips to help you create your most precise, most well-planned holiday season yet.







Add Pages to Your Sections







You're going to have some variety for each page within your sections. For instance, your Gifts section is usually going two different group in it: family and friends.



To create a Family page, go to the right sidebar in your OneNote window and click on “+ Add Page”. Do this as many times as you'd like. Now, you'll have your gift shopping tasks in their own section and organized by whether they're a friend or family member.







Use Photos and Links for Your Pages







Each page in your notebook will act as your source of information for finding the perfect gift for every person on you list.



Rather than just writing out the name of the person and the gift they want, get creative and add photos, audio and links to each person's wish list.



Image this scenario: you're driving down the road and you get a call from your mom. She tells you she's looking forward to seeing you on Christmas and mentions that your dad has been wanting a new set of knives for his kitchen. Your mom mentions the name of the knives and where you can buy them.



Now, everyone knows that, around the holidays, it's easy to forget subtle hints as to what loved ones or friends want for Christmas. OneNote's mobile app (which can be synced to the Holiday Planning notebook you made on your home computer) allows you to record up to 3 minutes of audio and add the audio to your notes page.



So, once your mom (or friend, or significant other) hangs up, open OneNote, find your notes page, click on the three squares in the top right of the screen and tap “Audio.” Record the gift idea and all the details. When you're done recording and you tap the Stop button, OneNote automatically adds the voice file to your notes page.



Or, if you're out with your family and someone points out a gift they'd like, you can always double-back and take a photo of the gift. Later, you can add the photo to your gifts page.







Make it a Team Effort







If you've got a lot of family and a lot of friends asking for presents, you won't be able to tackle your gits list alone. So, use OneNote's email tool to email your specific gifts page to people who can help you cross things off your check list.



Also, you can share your Holiday Planning notebook with whomever you want. Wives can share their planning folder with husbands and vice versa, making sure everyone is on the same page and letting more than one person cross things off your checklists.










Chapter 4 – Jump Start Your Job Search








If you're like most people, you don't get the first job for which you apply. And that means you'll be spending hours up hours every week searching websites and social media networks for the job that best fits your skills. It's never as easy at it sound, though.



The act of applying for a job usually requires a cover letter and a resume. A well-written cover letter alone can take an hour to write and edit.



Tailoring your resume to the opening your trying to win requires a constant retooling your experience and objective, not to mention the painstaking process of editing every letter, punctuation mark and sentence.



The responsibilities of your search go beyond cover letters and resumes, too. You'll be forced to organize the companies to which you apply, the email addresses of company contacts, the text of the original job posting and, hopefully, information about where and when your interview will take place.



The average person won't organize their job search. They may have a folder on their computer or phone in which they put their resume and cover letters. They might have a special folder in their email inbox to which they direct all emails related to their job search.



But, very few people have an organized system of job searching which includes all the information mentioned above.



So how can you organize your job search in a way that helps you respond quickly to inquiries and keep vital information about the jobs you really want? OneNote, of course.







The Job Seekers' Savior







Just like our example in the previous chapter, you'll need to utilize OneNote's notebooks, sections and pages in order to keep your job search organized and efficient.



First, create a “Job Search” notebook. Then, decide how you want to approach your sections. You can use each section to represent the jobs to which you want to apply. You can also use the sections for a different series of categories: resumes, job-site profiles and job applications.







Using Sections As Individual Job Opportunities







In the first scenario, you leave out the nuts-and-blots of your job search (resumes, cover letters and job site profiles) and focus each section on the employers for whom you want to work.



For each section, include the vital information about the position as well as what actions you've taken in the application process. Here's a good template for each section:



	
A table to keep track of when you applied, on which site you applied, whether or not you heard back and whether or not you received an interview


	
A checklist to determine if you've sent in all the information the employer has requested


	
The cover letter and resume you sent to the company (use the Insert function)


	
A link to the site on which you applied for the job or to the actual application


	
A text box that includes the user name and password you may have had to use to log in to the company's employment portal


	
A text box that includes the phone number, email address and name of the employer's HR contract.


	
A photo of the HR rep or recruiting contact









Make sure you include the company's name on each page. It sounds simple, but you be surprised at the type of details you can forget when you're trying to sort through dozens of job applications.







Using Sections as Components of Your Job Search







If you aren't going to apply to hundreds of jobs and you want to keep track of all components of your job search, consider using the following sections: resumes, job-site profiles and job applications.



This type of organization gives you a clear picture of how you are presenting yourself to employers (resumes and job-site profiles) as well as your actual job search (job applications).



Whereas the previous example required a section for every job, the current example uses one section for your job search, and within that section you can create individual pages for each job to which you apply.



These application pages would include the same information listed in the section above.



Your resume section would include all unique resumes you've sent to employers. Remember that various jobs may require various resume emphases, resulting in several different versions of your original resume.



A good suggestion is to name your resumes either by the name of the company to which you sent it (a difficult task if you send the same resume to multiple employers) or by the job-genre to which the resume corresponds.



For example, if you applied to three different companies with the same resume you could save the same resume three times, with each save featuring the name of the company you sent it to.



Or, if you sent the same resume to all three companies, you could save one version of it but give it the name of the industry in which the jobs were available: “marketing resume”, for instance.



Your Job-Site Profiles sections will include links to all of your job-site profiles, as well as any documents and pictures you have posted on the sites. To make things easier, you can create a new page for every job site.


















Chapter 5 – Planning the Perfect Vacation








Vacations are a wonderful thing.



They're your chance to escape the grind and enjoy the peace and quiet of a tranquil beach, a mountain retreat or a quaint hotel in the country.



In today's world, though, planning a vacation is like part-time job. We love to use ratings sites to figure out which hotels are best, which restaurants are the most popular and which attractions are worth a visit.



Each facet your vacation – plane tickets, rental care, accommodation, activities, food – requires a fair amount of research, and with that research comes a wealth of information you'll need to organize in a such a way that you can access it at a moment notice.



With OneNote's sync-ready notebooks, you'll be able to compile all the information you need so that it's readily available no matter if you're in the airport, on the road or settling in for a good night's sleep after a long day of sightseeing.







Taking Care of the Details







Look at your vacation like you would a travel agent's itinerary. You've got to have transportation in place, accommodation booked, activities planned and meals taken care of so you and your fellow travelers don't waste precious moments waffling over where to eat, what to see and where to sleep.



Start a notebook titled, “Vacation,” and from there, create a Transportation section, an Accommodation section, an Activities section and a Restaurants section.







Transportation







You'll probably be able to plan your transportation with just one or two pages. Let's assume you're going to use one page, and on that page you want to track airfare for a vacation to the Caribbean.



Start your notes by creating a table with dates down the left-hand column and the names of airlines or airfare websites across the top row.



Each day you check airfare prices, you can record the best prices on your ideal flight by entering a dollar amount under each airline or airfare website. For instance, if you check flights on Jan. 1 for four different airlines, you can enter their lowest fare in the “Jan.1” row under the “Delta”, “American”, “JetBlue” and “United” columns.



Next to your table you can create a checklist of must-haves for your flight so that, as you check prices and enter them into your table, you can make sure you're searching flights that meet your criteria for baggage allowances, departure and arrival times, layover times and other factors important to your air travel.



If you want to keep a visual record of your airfare search results, you can use the web snippet tool to take a scaleable screen shot of search results from your favorite airfare websites.



When you make your purchase, you can download copies of your receipts and your electronic boarding passes to your Transportation section so that you have everything you need for the day of travel.







Accommodation







Your accommodation section page will work much the same way your airfare page will, in that you can make a table that includes hotel names and prices.



Since you're room prices aren't going to fluctuate as much as airfare rates, you won’t have to make a list of dates and prices. Create one column called “Price” and then create as many rows as you need in order to include the name of each hotel you'd like to stay at.



Like your airfare page, you can also make a checklist next to your accommodation table. Include your must-haves, like room size, number of beds, amenities, hotel location and more.



Because hotels are more interesting in terms of rooms, facilities and location, create a new page for each hotel. Include on your hotel page a list of things you like about the hotel, a list of things you don't like, links to popular ratings websites like TripAdvisor and photos of each hotels rooms and amenities.











Activities & Restaurants







Your Activities and Restaurants sections can take elements from your Accommodation and Transportation sections, utilizing photographs and web snippets to help you decide where you want to eat and what you want to do.



One thing to keep in mind about all of these sections is that you can share them with the people who are traveling with you.



For instance, if you're going to vacation with your family, you can send out your Activities and Restaurants sections to your spouse and kids so they can see what's available in the location you're going to visit.














Conclusion








Organization is the key to getting things done.



Whether it's a simple trip to the supermarket, a holiday schedule packed with important events and checklists, a full-fledged job search or planning the vacation of your dreams, approaching your list of to-do's will take a valuable leap in efficiency and fun by using Microsoft's OneNote.



You've read about four different ways you can use OneNote to GTD, but remember that this powerful and easy-to-use tool isn't limited to the examples we've shown you.



The ability to include photos, web snippets and videos can be a huge help if you're working on redesigned your home or a just a single room in your house.



OneNote's tables and to-do lists can become the catalyst for a summer's worth of home repair projects. Make lists of what you have to do, enter in costs and time frames into your tables and use web snippets to grab photos of tools and resources that can help you get the job done.



The app has received rave reviews from lawyers and journalists who use the record function to record interviews. Being able to take notes that have the corresponding time stamp is a tremendous advantage.



The opportunities for maximizing your time and meeting your goals with OneNote are endless. It's time to GTD!
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